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Learning Unit 1: Identify the elements of Arc GIS interface  
 

LO 1.1: Identify Pull-down menus. 

● Content/Topic 1: Menu classification 

Many of Esri's applications, including Arc Map, Arc Globe, Arc Scene, and Arc GIS Publisher, 

have a Main menu and Standard toolbar that appear by default. Both are referred to as 

toolbars, although the Main menu toolbar contains menus only. 

The Main menu and Standard toolbar 

 

Adding a command to a toolbar or the main menu  

You can modify the contents of any toolbar or menu by adding, moving, and removing 

commands. After modifying a core toolbar, you can always return it to its original contents; you 

might want to do this if you accidentally remove a command from the toolbar. 

1. Make sure the target toolbar is visible. 

2. Click the Customize menu and click Customize Mode. 

3. Click the Commands tab. 

4. Click the category that contains the command you want to add. 

5. Click the command you want to add. 

6. Drag the command you want to add to any location on the target toolbar. 



You can also drag the command over a menu button on the main menu. Once the menu 

opens, drop the command at the desired location within that menu. 

7. Repeat steps 5 through 7 until all the commands you want are added. 

8. Click Close on the Customize dialog box. 

Tip: 

The list of commands can be filtered by entering a search string in the Show commands 

containing edit box. The search is case insensitive, and only commands with matching captions 

are listed. The category list changes based on the matching commands. Note that the Menus 

and New Menu categories are always listed. To cancel filtering, leave the Show commands 

containing edit box empty and delete any blank space. 

LO 1.2: Explore main toolbar items 

● Content/Topic 1: Editor toolbars 

Editing is the ability to create and change vector and tabular (table) data within Arc Map. Data 

does not always exist or may not always correct, and the only way to make or fix it is with 

editing. 

 

Start Editing Begins an editing session. Once in an editing session, modifications to existing can 

be made. (Even with digitizing new data, it is still a modification to existing data since you 

created a new feature class before editing, then plan to populate it with editing.  

 

Stop Editing Stops the editing session.  

 

 



 Stopping editing does not automatically save edits, but should provide you with a prompt to 

save or discard your edits. 

 Tools which are locked during editing will become available when editing is stopped. 

 

Save Edits Note: Unlike some software, ArcGIS ‘undo’ will only go back to the last save not the 

beginning of the software session.  

 

Merge... i.e. The State of Hawaii. All the islands are part of the state, but as a single part 

feature, each individual island will be a record in the attribute table. Merging them into a 

multipart feature will ‘light up’ all the islands when the record ‘Hawaii’ is selected in the 

attribute table. ArcGIS Help Article   

 

Snapping ►    Opens the Snapping toolbar. The Snapping toolbar 

controls to what (Point, Edge, Vertex, End) your cursor will snap when editing. 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Merging_features_in_the_same_layer/001t0000007q000000/


 

Edit Tool 

 

1. Used to select the feature you want to edit 

2. Any selectable feature is available to select.  

3. When two or more features are selected when clicking, a selection drop down     will 

appear for you to choose one.  

4. Not choosing selects the top most layer 

Straight Segment 

 



Used to create lines. Each click puts down one vertex, then connects a straight line to the next 

vertex clicked.  

Vertices will continue to be placed until you finish 

your sketch 

1. F2 

2. Right click and ‘Finish Sketch’ 

3. Double-click 

 

End Point Arc Segment 

 

 

The ‘end point arc segment’ tool creates a curve between the two end vertices laid down. 

1. Click where the curve should 

start 

2. Click where the curve should end 

o The tool automatically starts 

curving between the two points 

as you move your mouse around 

3. To end sketch: Double click; right-

click and choose “End Sketch”; 

press F2 
 

Edit Vertices 



 

 

Edit Vertices is a tool that allows you to move or delete one or more existing vertices, as well as 

add new vertices to the feature. For example, if you have a road that is in the correct place, but 

the previous technician represented a pretty steep curve with just a few vertices, you can add a 

few more then move them into place to create the best line representation possible.  

Reshape Feature Tool 

 

 

Reshape Feature allows you to select a single feature and change a portion of it, for example, if 

you have a river that shows it is flowing right through a building and you can see in the imagery 

it actually flows to the south of that building, you can select that river and use the Reshape 

Feature tool to draw along the actual path to get people out of “harm’s way”. 

Continue Feature Tool 

 

Cut Polygon Tool 

 

Split Tool 

 

Rotate Tool 



 

Attributes Window 

 

Sketch Properties 

 

Once in ‘Edit Vertices’ mode, the sketch properties window can be opened with the ‘Sketch 

Properties’ button. You can mark off multiple vertices to delete whole parts of your feature 

class at once. See screenshot for more details Sketch 

Properties 

 



Create Features Window 

 

 

Toggles the ‘Create Features’ window on and off. 

Use this button if you’ve X’d your window closed and it will not automatically appear when you 

begin an edit session. 

 

● Content/Topic 2 : Draw toolbars 

1. Turn on the Draw toolbar. To do so, please click on the menu of Customize -> Toolbars -

>Draw  

 

 

2. Add Marker. Click on and select Marker. Then browse and point to the location you 

want to add the marker (South Campus Hall in this case) and click. A marker will be added to 

the location.  

 

  



● Content /Topic3 (Layout toolbars 

When ArcMap is switched from Data View to Layout View, a new toolbar appears. This toolbar 

includes options to adjust the view of the whole page, not the data within. For example, if you 

are working on a corner of your layout, attempting to line up the legend and credits in a neat, 

clean way, you could zoom in to that corner, using the page zoom in tool. When you are ready 

to move to another section, you can use the page pan tool. 

 If the layout toolbar is missing, add it from: Customize Menu > Toolbars > Layout 

 In order to pan and zoom the data within a data frame, it is necessary to use the pan and zoom 

tools found in the Tools toolbar 

 

Page Zoom In 

 

Use the Page Zoom in tool to draw a box and zoom to a portion of the layout 

Page Zoom Out 

 

 

Use the Page Zoom Out tool to draw a box and zoom out from a portion of the layout 

Page Pan 



 

 

Use the Page Pan tool to move the entire page around in layout view 

Zoom Whole Page 

 

Use Zoom Whole Page to center the entire page at a zoom level where the entire page is 

shown. 

*Use this button when you’ve “lost” you work. This button is the layout version of “Full Extent”, 

found in the Tools Toolbar 

Zoom to 100% 

 

 

This tool will set the zoom level to 100%, regardless if the whole page can be seen or not. 

Page Fixed Zoom In 

 



 

Use this button to zoom in a stepped manner. 

Page Fixed Zoom Out 

 

 

Use this button to zoom out in a stepped manner 

Page Last Extent 

 

 

This button will move through the last zoom levels, similar to using the “back” button in a web 

browser. 

Page Next Extent 

 

 

This button will move through the next zoom levels, similar to the using the “next” button in a 

web browser. 

Zoom Level (Percentage) 



 

 

This dropdown both shows the current zoom level in percent, but also allows for specific zoom 

levels to be chosen. A custom zoom level can be set by typing the number in the box (10% - 

1000%) 

Toggle Draft Mode 

 

 

This button will toggle the “draft mode” option. Draft mode will pause all drawing, showing just 

grey box with the data frame name. This is handy when the data is complicated or numerous, 

and you don’t need to see the data to set the layout, such as when creating and placing 

legends, north arrows, and additional text boxes. 

Focus Data Frame 

 

 

Puts the currently outlined data frame into focus, making it the target for graphics and text. 

  



Change Layout 

 

 

Changes the layout to a predefined template. Handy if you’ve created a custom template, 

complete with legend, title, credits, and company logo. 

LO 1.3: Explore table of content. 

● Content/Topic 1: Listing by drawing order 

Use List by Drawing Order   to author the contents of your map, such as to change the 

display order of layers on the map, rename or remove layers, and create or manage group 

layers. All the data frames in your map are listed when the table of contents is sorted by 

drawing order. However, only the active data frame indicated by a bold data frame name is 

shown in the map in data view.  



 

The order of layers determines how layers are drawn on a map. Within a data frame, the layers 

listed at the top will draw over those in the list below them, and so on, down the list. You can 

easily drag and drop layers to adjust their drawing order or organize them in separate data 

frames.  

To turn on or off a layer, click the check box next to the player’s name. Right-clicking opens a 

menu containing many commands for working with layers, including accessing their properties, 

zooming to them, selecting from them, and opening their attribute tables 

 

 



● Content/Topic 2: Listing by source 

Click List by Source to show the layers in each data frame with the layers organized by the 

folders or databases in which the data sources referenced by the layers can be found. This view 

will also list tables that have been added to the map document as data.  

 

This view is very useful for managing and repairing each layer's path reference to its data source in your 

map document. 

● Content /Topic3: Listing by visibility 



Click List by Visibility to see a dynamic listing of the layers currently displayed in the active 

data frame. The way layers are listed updates automatically as you pan and zoom, interact with 

the map, select features, and turn layers on and off.  

Listing layers by visibility helps you visually simplify and organize a detailed or complicated map 

with many layers. Since the organization of the table of contents visibility list is controlled 

automatically, you cannot change the order or groupings of layers manually. Layers within a 

group layer are listed individually, since each layer can have its own visibility and selection 

properties. You can choose to display the group layer's name beside the layer's entry on the 

Table Of Contents Options dialog box. 

 
With List by Visibility, you have visual cues to indicate the layer's visibility. Each type of layer 
has its own icon, and the symbol is either colored to indicate the layer is on or gray when it is 
not, so you can quickly look at the icon to determine whether a layer is visible.  
When layers are listed by visibility, they are grouped into these categories: 



 Visible: The layer is turned on. 
 Out of Scale Range: The layer has a visible scale range and is not being displayed at the 

current map scale. To bring it back into view, right-click and click Zoom To Make Visible. 
 Not Visible: The layer is turned off. To turn it back on, click the icon to the left of the 

layer name.  
 To turn a layer on or off, click the layer icon to the left of the layer name, such as for 

a line layer or for a polygon layer. To make a layer selectable or not selectable, click 

the selection icon to the right of the layer name. If that icon is colored , the layer is 

selectable; if it is gray , the layer is not selectable.  

 Content/ Topic 3: Listing by selection 

 Click List by Selection to group layers automatically by whether or not they are 

selectable and have selected features. A selectable layer means that features in the 

layer can be selected using the interactive selection tools, such as those on the Tools 

toolbar or the Edit tool, when in an edit session.  

 



Learning Unit 2: Perform Arc Map 

LO 2.1: Display data in Arc Map Window 

● Content/Topic 1: File format in Arc GIS 

The following are the file format work in Arc GIS: 

 Excel  

 Tab delimited  

 Notepad  

 Shape file  

 Raster dataset  

Tabular data 

 Tabular data includes things like comma delimited or fixed width text files, Excel worksheets, 

Access files, and dbase files. This is where you store attribute data, which includes any 

information you have about a location. For example, you might know the types of programs 

offered at a recreation center or the total population of a zip code. In order to be mapped, 

tabular data generally needs to be linked to spatial/ geographic data. Unlike some earlier 

versions (8 and earlier), Arc GIS 10 can work with Excel files. When you add an Excel file to Arc 

Map, you must specify which worksheet you wish to add, so try to remember to name your 

worksheets in Excel (no spaces in the name). When you add data, double-click on the name of 

the .xls file to see the names of the worsheets. Highlight a worksheet and click “add.” 

Raster models 

 In a raster model, the world is represented as a surface that is divided into a regular grid of 

cells. 

Raster models are useful for storing and analyzing data that is continuous across an area. Each 

cell contains a value that can represent membership in a class or category, a measurement, or 

an interpreted value. Raster data includes images and grids. Images, such as an aerial 

photograph, a satellite image, or a scanned map, are often used for generating GIS data. 



 

Vector models  

One way of representing geographic phenomena is with points, lines, and polygons. This kind of 

representation of the world is generically called a vector data model. Vector models are 

particularly useful for representing and storing discrete features such as buildings, pipes, or 

parcel boundaries. 

Points are pairs of x,y coordinates. Lines are sets of coordinates that define a shape. Polygons 

are sets of coordinates defining boundaries that enclose areas. 

 

  



● Content/Topic 2: Steps ofdata display 

ARCMAP INTERFACE 

 



 

To launch Arc Map you can start by: 

 If you have a shortcut icon for Arc Map  on your desktop, double-click it to start 

Arc Map.   

 You can start also by clicking: Start -> All Programs -> ArcGIS -> ArcMap 10. By default, 

a start-up splash window will appear once ArcMap has loaded (Figure 1).  

Click OK to proceed. You can ignore all other options. They are redundant. 

1. When the first dialog box comes up, go to My Templates – Blank Map and press OK.  

 



 

 

 

2. Choose Customize – Toolbars, and make sure that Standard and Tools are checked.  

3. On the left side of the screen, you should see your Table of Contents area – right now it 

should only say "Layers". If you do not see this separate area, choose Windows – Table of 

Contents.  

4. Below is the Standard Toolbar:  

 

 

 

5. Click on the "plus" sign ( ) to add data  



There are two ways to add data: Click the Add Data button (Figure 2), which opens a 

window similar to Figure. 

 

 

Connect to Folder  

To browse to the file you want to play with, you can link to the folder containing all these files 

by clicking the Connect to Folder button in Figure 3, then browse to add the folder that 



contains your files and click OK. After that, you can locate the files listed below and add them in 

at one time by holding the Ctrl or Shift button when you are clicking mouse button to make 

selections. Please click the Add button just like any other file explorer dialogs in Windows to 

close the dialog.  

schools_dec06.shp: All schools in the City of Waterloo;  

waterloo_city.shp: The administration area of the City of Waterloo;; 

WSLSN_feb08.shp: Roads in the City of Waterloo;  

AirPhoto.jpg: A resolution-decreased airphoto image of the City of Waterloo.  

 

When data is loaded, all files will be listed in the left pane (table of contents) in Figure 4. The 

geographic features (contents) are displayed in the right pane. And most controls can be found 

on the top pane (or by right-clicking on the object you are working at and checking the pop-up 

window). 

 

 



 

8. If you missed one of the above layers, simply click on the Add Data icon again and add the 

data set you missed.  

9. Next, choose the Add Data icon again, but go back up the folder path one level ( ) and 

navigate to the Hydro folder. Add Lakes.sdcand Rivers.sdc 

 

 

10. Finally, you need to add roads – go back up the folder path again and navigate to the Trans 

folder and add the following data layers  



 

 

 

11. All the data layers added will appear in your map – a big mess!  

12. Try turning off the Places data layer by unchecking it in the Table of Contents  

13. Try turning on and off some of the other layers – for example, show a map of only states, 

lakes, rivers, and interstates by turning off everything else.  

 

14. Label the rivers by right-clicking on the Rivers layer name in the Table of Contents and 

choosing Label Features  



 

 

 

15. Try labeling some of the other layers.  

16. Turn off all the labels for now by right clicking on each layer and unchecking Label Features  

17. Now choose File-Save. Navigate to your H: drive. Name the map file US_basemap1.mxd. 

This action creates a map file (.mxd). A map file is a very small file that contains pointers to your 

data sets and remembers what you had up in your session. If you quit ArcMap at this point, the 

next time you start it, you can choose to start with this existing mapfile and it will automatically 

pop up all the data layers you added in your first session and with the view of the data just as 

you left it. Thus, map files are easy ways to save work.  



LO 2.2: Explore layer properties 

● Content/Topic: Layer properties 

 Projection 

One of the very first things that you should do after adding data is to set the map and display 

units. It is also a good idea to set the projection (if desired) at this stage as well. Setting these 

units will allow you to measure distances or compute areas. Display units should also be set if 

you are planning to create a map layout with a distance scale. 

Projections are probably the trickiest part of working with spatial data. The stakes are high 

because if data are not projected properly, you might not even get your map layers to draw 

together. Don’t be afraid to ask someone for help or to start over (download the original data 

again). Hopefully there is some consultation in knowing that most people have a hard time with 

this stuff. 

 Working with “Unprojected” layers 

In most cases, you will want to convert unprojected map layers—those with a geographic 

coordinate system—to projected map layers. Any of the files you download from the US census 

website or Esri TIGEr files site will be in this “unprojected” format. There are two steps involved 

in this process. First, you must create a .proj file by “defining” the map layer as unprojected; 

then you can “project” the map layer using the projection of your choice. You can access the 

tools for doing this by clicking on the Arc Toolbox icon inside Arc Map. Click on “data 

management tools” and then “projections and transformations.” 



 

 Projecting shape files  

Projecting a shape file changes the projection system. You can only do this if you have defined 

(registered) the existing projection. You can project map layers that are unprojected 

(geographic coordinate system) or change the projection on layers that already have a 

projected coordinate system. In order to project the map layer, click on the “Project” wizard. If 

you are projecting a shapefile, use the “Project” wizard listed under “Features.” If you are 

projecting a raster image, use the “project” wizard listed under “raster.”  

As with the “define” wizard, you will be asked to specify the map layer. Next, because you will 

be changing the original layer, you are asked to name the new layer that will be created. 



 

 For the case of Rwanda, the following is a conventional coordinate system to be set 

and used by any GIS user: 

Projected Coordinate System: ITRF_2005 

Projection: Transverse Mercator 

False Easting: 500000 

False Northing: 5000000 

Central Meridian: 30 

Scale Factor: 0.9999 

Latitude Of Origin: 0 

Linear Unit: Meter 

Geographic Coordinate System: GCS_ITRF_2005 

Datum: ITRF_2005 

Spheroid: GRS_1980 

 

 Coordinate system  

Map layers can be drawn according to a geographic coordinate system (unprojected) or 

projected coordinate system. Geographic coordinate systems indicate location using longitude 

and latitude based on a sphere (or spheroid) while projected coordinate systems use X and Y 



based on a plane. As long as computer screens and printed maps are flat, projected coordinate 

systems will be more appropriate for working with GIS data. 

 

 

 Symbology  

Symbology is critical in making maps, which are classified into four categories in ArcMap. 

Due to its complexity, these four categories and their normal usages will be briefly 

introduced in the note region with further reading. We will only focus on symbol 

customization and classification symbols, which are mostly used.  

Please right-click the schools_dec06 layer and select Properties. Then switch to the 

Symboloytab and click on the Symbol (Figure 12). The pop-up window (Figure 14 contains 

three main parts. In most cases, you will simply choose a symbol from the symbol library 

(other than making hallow polygons mentioned in 2.2.1.). Depending on the type of the 

feature (point, line, or polygon), the options change accordingly.  

You can type in school and click the search icon (magnifier) to search all symbols related to 

school representations.  



 

Figure 14. Symbology Customization Window with Explanations 

There are cases when you want to differentiate features in a layer based on some attribute. 

For instance, I want to know which schools are public, separate, or for higher education in 

the schools layer, which is the top layer in Figure 11. Different types will be marked in 

colors. To do so, we should right-click on the school layer, select properties, and go to the 

symbology tab, which is the same as shown in Figure 12. But, instead of by-default 

Features option, we should click and select the categories option (Figure 15). The steps to 

follow are also shown in Figure 15:  

1. Click on the Categories first and make sure the “Unique Value” is chosen;  

2. Draw down the dropbox of Value Field, and select TYPE as the classification attribute;  

3. Click on the Add All Values button to add all distinct values under the TYPE attribute into 

consideration;  

4. (Optional) Click on the Color Ramp dropbox and select your favourite color schema.  



 

Figure 15. Classifying Features using Colors 

The result is shown in Figure 16. Please note that you can still customize individual symbol 

for each category (size, shape, etc) by double clicking corresponding class on either the left 

pane or the line in symbology window (Figure 16). The pop-up window is very similar to the 

window in Figure 14. Please choose School 1 for each class. Don’t worry about the color, 

Arc Map can manage it. 



 

Figure 16. Classified Symbols and Further Customization 

 Label  

The labels are an important feature of a map. By marking some property up on the map, for 

stance, the name of the marked location, labels can make your map more useful, 

informative, and visually appealing.  

To add labels to your map, please right-click on the layer that you want to add marks on 

(school_dec06) and select Properties (Figure 12). Then follow the steps below:  

1. Select the Labels tab and check on (off by default) “Label features in this layer”.  

2. Choose the attribute you want to display (NAME) on the map in the dropbox of Label 

Field (Figure 17).  

3. Change Font (10 pt size and Bold), so that it is clearly shown on the map.  

4. You can click on the Apply button to see the effect until it is satisfactory. Then click OK to 

save your setting and exit.  



 

Figure 17. Label Setting Window  

To ensure a clear label, the option of mask can be used Symbol, which locates to the right 

of Font options as a Symbol button (Figure 17). Please click it and then click the Edit 

Symbol button, since label is a kind of symbol (text symbol) too. Navigate to the Mask tab 

shown in the figure below. Change the option of Style to Halo (Figure 18). 

 

Figure 18. Change Mask Option for Clearer Labels 

  Annotations  



Annotations look like labels. The key difference is that annotation can be any text you want 

to add on the map, regardless to whether the information has been included in the 

geospatial data.  

For instance, if you want to add a point at the entrance of UW, which is not in the 

geospatial data, please follow the steps below (Please note that annotations can only be 

edited under the data view):  

1. Turn on the Draw toolbar. To do so, please click on the menu of Customize -> Toolbars -

>Draw (Figure 19).  

 

2. Add Marker. Click on   and select Marker. Then browse and point to the location 

you want to add the marker (South Campus Hall in this case) and click. A marker will be 

added to the location.  

 

 

● Content/Topic 2: Layer types 

 Shape files  

 Arc GIS shape file format is a widely adopted standard and comprises three or more associated 

files. Be careful copying this data to a disk. You must get all of the files associated with a single 

layer. They will have a variety of file extensions: .shp, .shx, .dbf and sometimes others. If you 

are copying shape files, we recommended that you use the ‘File’ > ‘Data’ > ‘Export Data’ 



function in Arc Map or through Arc Catalogue. This will automatically copy all files associated 

with a layer. Also, be aware that some of these files may be very large in size.   

 Layer  

Layers are the mechanism used to display geographic datasets in Arc Map, Arc Globe, and Arc Scene. 

Each layer references a dataset and specifies how that dataset is portrayed using symbols and text 

labels. When you add a layer to a map, you specify its dataset and set its map symbols and labelling 

properties. 

According to ESRI, the layer file (.lyr) stores symbology, symbology classifications, labelling 

properties, scale dependency, and definition. If you save something in this format it means 

that, unlike shape files, colours and other characteristics are saved and will appear the same 

every time you open it. 

 Raster layer 

In its simplest form, a raster consists of a matrix of cells (or pixels) organized into rows and 

columns (or a grid) where each cell contains a value representing information, such as 

temperature. Rasters are digital aerial photographs, imagery from satellites, digital pictures, or 

even scanned maps. 

 

Data stored in a raster format represents real-world phenomena: 



 Thematic data (also known as discrete) represents features such as land-use or soils 

data. 

 Continuous data represents phenomena such as temperature, elevation, or spectral 

data such as satellite images and aerial photographs. 

 Pictures include scanned maps or drawings and building photographs. 

Thematic and continuous rasters may be displayed as data layers along with other geographic 

data on your map but are often used as the source data for spatial analysis with the ArcGIS 

Spatial Analyst extension. Picture rasters are often used as attributes in tables—they can be 

displayed with your geographic data and are used to convey additional information about map 

features. 

o Raster as base map 

A common use of raster data in a GIS is as a background display for other feature layers. For 

example, orthophoto graphs displayed underneath other layers provide the map user with 

confidence that map layers are spatially aligned and represent real objects, as well as additional 

information. Three main sources of raster base maps are orthophotos from aerial photography, 

satellite imagery, and scanned maps. Below is a raster used as a base map for road data. 

 

o Raster as surface maps 

Rasters are well suited for representing data that changes continuously across a landscape 

(surface). They provide an effective method of storing the continuity as a surface. They also 



provide a regularly spaced representation of surfaces. Elevation values measured from the 

earth's surface are the most common application of surface maps, but other values, such as 

rainfall, temperature, concentration, and population density, can also define surfaces that can 

be spatially analyzed. The raster below displays elevation—using green to show lower elevation 

and red, pink, and white cells to show higher elevations. 

 

o Raster as thematic maps 

Raster representing thematic data can be derived from analyzing other data. A common 

analysis application is classifying a satellite image by land-cover categories. Basically, this 

activity groups the values of multispectral data into classes (such as vegetation type) and 

assigns a categorical value. Thematic maps can also result from geo-processing operations that 

combine data from various sources, such as vector, raster, and terrain data. For example, you 

can process data through a geo-processing model to create a raster dataset that maps 

suitability for a specific activity. Below is an example of a classified raster dataset showing land 

use. 

 



o Raster as attributes of a feature 

Raster used as attributes of a feature may be digital photographs, scanned documents, or 

scanned drawings related to a geographic object or location. A parcel layer may have scanned 

legal documents identifying the latest transaction for that parcel, or a layer representing cave 

openings may have pictures of the actual cave openings associated with the point features. 

Below is a digital picture of a large, old tree that could be used as an attribute to a landscape 

layer that a city may maintain. 

 

LO 2.3: Overlay data 

● Content/Topic 1: Data content 

 Coordinate system: Arc GIS stores features using x,y coordinates. These coordinates are linked to 

real-world locations by a coordinate system. The coordinate system specifies a datum and a map 

projection.  

 Datum 

A datum is a mathematical representation of the shape of the earth’s surface. A datum is defined by 

a spheroid, which approximates the shape of the earth and the spheroid’s position relative to the 

center of the earth. There are many spheroids that represent the shape of the earth and many 

more datums based on them. A horizontal datum provides a frame of reference for measuring 

locations on the surface of the earth. It defines the origin and orientation of latitude and longitude 

lines. A local datum aligns its spheroid to closely fit the earth’s surface in a particular area; its origin 

point is located on the surface of the earth. 



 

 Map projection 

Map projections are systematic transformations of the spheroidal shape of the earth so that the 

curved, three-dimensional shape of a geographic area on the earth can be represented in two 

dimensions, as x,y coordinates. Maps are flat, but the surfaces they represent are curved. 

Transforming three-dimensional space onto a two-dimensional map is called projection. 

Projection formulas are mathematical expressions that convert data from a geographical 

location—latitude and longitude—on a sphere or spheroid to a representative location on a flat 

surface. 

 

 Layer content 

● Content/Topic 2: Data symbology 

The various symbology options are listed on the left side of this window (Features, Categories, 

Quantities, Charts, and Multiple Attributes). 



 Features: The feature symbol is used when you draw all features using the same symbol 

click on the symbology tab 

 

 Categories: is used when Assign symbology based on unique values (ex. state names) 

Displaying Categorical Data: If you have data that includes distinct categories, such as codes 

for land use, grade level, type of building, etc. you can display those individual categories 

on the map. 

1. Right on the data layer in the table of contents window and select Properties. 

2. Click on the Symbology Tab. 

3. Click on Categories. There are different ways to display categorical data. The first 

option under Categories is unique values, which will assign a different color to each of 

the different categories in your data. 

1. Select your variable of interest in the Value Field drop down menu. 

2. Click Add All Values at the bottom of the box. 



3. Click Ok. 

 

Change the colors by selecting a different color ramp from the color ramp drop down box or 

double click on the individual color boxes for each category and assign a specific color to each 

category. 

 



 Creating New Categories 

You can combine the categories from up to 3 fields to create new categories by clicking onthe 

next option under Categories: Unique value, many fields. For example, if you have a column 

that specifies the color of a house and a category that specifies the type of house, this tool will 

create a category for every color and type combination, such as blue, cape; blue, colonial; red, 

cape; etc. 

1. Select up to 3 different variables under Value Fields. 

2. Click “Add All Values” or “Add Values...” to select specific values. The values from all variables 

will be combined to create new categories. 

3. Change the colors as appropriate. In this example, the variables, flood zone and floodway 

were combined to create 3 new categories that will be displayed on the map. 

 

Other things you can do in the Categories box: 

Uncheck the box next to <all other values> to not display values that do not fall into a 

category. 



Right click on a category to remove it. 

Add values one by one, by clicking on “Add Values...” 

Click Advanced to: 

o Change the transparency of symbols 

o Change the drawing order of the symbols (which are drawn on top vs. the bottom)oJoin 

or merge overlapping symbols 

 Quantity: is used if you to get graduated colors, graduated/proportional symbols, and 

dot maps 

o Graduated Colors 

To change the display to different colors:  

1. Right click on the layer and select “Properties” and then the Symbology tab. 

2. Select “Quantities” from the menu on the left and “Graduated Colors.” 

3. Choose your variable of interest from the “Value” drop down menu. 

4. By default, your data will be broken into 5 categories. 

 



To change the number of categories, select a different number in the “Classes” drop down 

menu. To further modify the classification, click on “Classify...” 

You can change the method of classification, see some basic statistics, or manually choose 

the Break Values, by selecting a number in the Break Values box and typing a new one in its 

place. 

 

You can also exclude certain values, such as outliers or values that denote missing data. 

1. Click on “Exclusion...” in the Classification menu. 

2. Select your variable of interest and set it equal to the value you want to exclude. 



 

o Graduated Symbols 

Graduated symbols displays your numeric data with a symbol of a certain size. You can change 

the range of the symbol sizes as well as the type, color and number of classes. 

 



o Proportional Symbols 

The proportional symbols display symbols in direct proportion to the numbers you are 

displaying. The symbol that corresponds to a value that is equal to 10 would be about 10 times 

smaller than a symbol that corresponds to a value of 100. 

 

This map displays yellow dots in proportion to the aggregate travel time to work for males in 

each census tract. Dots that are twice as large as other dots indicate that the aggregate travel 

time to work in that census tract is approximately twice as large as the tracts with smaller dots. 

 



o Dot Density 

Dot density is similar to proportional symbols in that the number of dots in any given area is 

directly related to the numbers from the attribute table that you are visualizing. Polygons with 

larger numeric values will contain more dots. You can adjust the density, color, size, etc. 

 

LO 2.4: Measure distance 

● Content /Topic1:Use measuring tools 

Now that we have set the map and display units, let’s make some measurements. On the tools 

toolbar there is a button that allows you to measure elements of the layers. The measure tool is 

the button having the icon composed of a question mark within an arrow over the ruler.   

 

1. Click the measure tool with the left mouse button. Your cursor changes to an L-shaped ruler 

with cross hairs and you get a pop-up window.  



 2. Move the cursor to the point on the map where you want to start measuring and click.   

3. Now move the cursor to the point where you want to stop measuring and double-click.    

Observe in the window the measurement you just made. This measurement is composed of a 

segment length and total length. It also indicates the display units of measurement.  To change 

the units, click on the drop-down arrow next to the sum symbol. 

 

You can take measurements that are composed of multiple segments that do not follow a 

straight line. To do so:   

1. Click the measure tool with the left mouse button.    

2. Move the cursor to the point on the map where you want to start measuring and click once.   

3. Now move the cursor to the next point along your defined path and click once. The first 

segment is defined.   

4. Now move to the second point along your defined path and click once.   The second segment 

is defined.  5. Repeat this process until you reach the point where you want to stop, and 

double-click.    

● Content /Topic2: Measuring unit 

 Meters  

 Feet  

 Yards  

 Inches  

 Miles  

If you wish to measure in some other format (for example, kilometers instead of miles), you can 

also go back to the data frame > ‘Properties > and change the display units. 



LO 2.5: Identify Raster and Vector data 

● Content /Topic1: Identification of Raster data 

Raster models are useful for storing and analyzing data that is continuous across an area. Each 

cell contains a value that can represent membership in a class or category, a measurement, or 

an interpreted value. 

 Grid: Grids represent derived data and are often used for analysis and modelling. They 

can be created from sample points, such as for a surface of chemical concentrations in 

the soil, or based on classification of an image, such as for a land cover grid. Grids can 

also be created by converting vector data. 

 Pixel size: 

 Resolution:  

 

● Content /Topic2: Identification of Vector data 

One way of representing geographic phenomena is with points, lines, and polygons. This kind 

of representation of the world is generically called a vector data model. Vector models are 

particularly useful for representing and storing discrete features such as buildings, pipes, or 

parcel boundaries. 

 Line: Lines are sets of coordinates that define a shape. 

 Point: Points are pairs of x,y coordinates. 

 Polygon: Polygons are sets of coordinates defining boundaries that enclose areas. 

LO 2.6: Perform Geo-referencing  



Data is geo-refenced when coordinates from a geographic space have been associated with it. 

Geo-referencing is establishing the relationship between digital map elements and real word 

geographic coordinate location systems.  

I. Real-world coordinates = an x, y coordinate system used to represent geographic 

locations.  

 If a digital map to geo-reference has spatial grid, the geo-referencing is done based on 

junction of XY coordinates in spatial grid; 

 If there is no spatial grid, the geo-referencing is done based on visible features similar 

on both digital map to geo-reference and the base map 

(ortho-photo, satellite image, etc); 

 If there is no base map; the geo-referencing can also be done by identifying features on 

map which can also be identified on field. In that case, the GIS user has to go to the site 

with GPS receiver and take XY coordinates. 

 Content /Topic1: Auto registration 

 Add control points: In Arc GIS, after opening the Arc Map application, click on View 

menu, 

Toolbars Geo-referencing to have the geo-referencing toolbar: 



 

 

The Georeferencing toolbar displays in this way: 

 

 Adding coordinates on map sheet 

Add button to add an image to georeference in 

ArcMap. This image is for example a scanned map; 

 

weather both the photo and the scanned sheet to georeference match; 

t) to georeference displays 

farther from the aerial photo, what means it has no geographical coordinates that enable it to 

match the orthophoto. Thus, it is not georeferenced; 



Georeferencing toolbar from the View menu, if it is not ticked; 

 

 image well georeferenced must bear at least 3 control points distributed towards the 

image’s angles (corners). A control point is just a geographical coordinate, which is a couple (X, 

Y), X being Longitude and Y being Latitude; 

s angles until you see the intersection of X and Y lines, then zoom in 

the pixel located in the intersection of lines; 

 

 

 



 

 

Georeferencing toolbar, click on the Add Control Point command to add a coordinate 

on the image; 

 

of intersection of lines to mark it with the control point. 

The point appears then in green cross; 

 

-click on the pixel of intersection and you are asked to choose among options; 



 

Input X and Y.  A coordinate’s box appears; 

 

llels (or latitude) shift 

with meridians (or longitude), what is the case of the image shown in the following figure. 

Consequently the Xs shift with the Ys; 



 

OK. The green cross indicating a control point turns in red, to mean that a coordinate 

has just been written; 

he map for the remaining 2 or 

3 angles (corners) of the map sheet. But it’s better to limit number of corners to 3 in order to 

reduce degree of distortions. Finally, you can notice that the map sheet matches well the 

orthophoto, according to the correct overlay of the same area they both represent. 

● Content/Topic 2: Adjust Geo-referencing 

 Rectify: In the Geo-referencing toolbar, click on Geo-referencing drop-down arrow 

Rectify. A Save As dialog box to fill in appears; 



 



 

The map sheet now geo-referenced. You can modify the Output Location and the 

Format in which to save. We have chosen to save in TIFF format because the sheet, previously 

in JPEG format, becomes more brilliant. 

LO 2.7: Perform Digitization 

● Content/Topic 1: Select folder and data 

. Creating folder 

 Before  starting any vectorisation task it is important to organize the data that are going to 

be used. This will make your work more cohesive, and avoid any loss or useless copying of data 

which takes more disk space; 

 Start by  creating a folder on C or D or any other Directory with enough space on your 

computer; 

 This folder  will be your work space because all of your data will be saved in it. 

 Once the main  folder is created; you will create sub-folders within it. 



These will be organized according to the administrative units. 

 Example: Province, District, Sector, Cell; 

Creating a geodatabase 

 The  geodatabase is a collection of geographic datasets of various types; 

 To create a  geodatabase you have to launch/start ArcCatalog; 

 In the ArcCatalog,  right-click the cell folder or open the folder; 

 New;  

 File  Geodatabase; 



 

 The new Geoatabase is created inside that folder, and   give it a name such as  

South (Example: Southern province) 

Creating a Feature Dataset 

 Once the  Geodatabase is created, right click on it or open it 

 New  

 Feature  Dataset 

 



 Name it  "Southern Province"  

 Click Next  

 

 A new dialog  box appears 

 Click New  Projected 



 

 A new  projected coordinate system dialog box appears. And fill it as 

follows: 

1. Name: ITRF_2005 

2. Projection Name: Transverse_Mercator 

3. - False_Easting: 500000 

- False_Northing: 5000000 

- Central_Meridian: 30 

- Scale_Factor: 0.9999 

-Latitude of Origin: 0 

- Click “Select” on the Geographic Coordinate System area 



 

 

Creating Feature Class 

In the Arc Catalog right click on the Feature Dataset or open it 

 New  

 Feature Class  



 

 A New Feature  Class dialog box opens; fill it as follows: 

 Name: Cell name_Vectorised (Rurambi_Vectorised) 

 Type: Polygon  Features 

 Click “Next’’  

 You are  redirected to New Feature Class dialog boxes 

 Click Next  

 Next  

 Finish  



 

 



 

Order of folders and data inside the working space 

 



● Content/Topic 2; Use editor tool 

Vectorising using the Editor Toolbar 

o Turn on the 

o Editing Toolbar on the Standard Toolbar in ArcMap; 

o Set the correct Target (....); 

o Choose the Create New Feature task; 

o Click the Sketch Tool and digitize the target layer; 

 

o You can drawpolygons by clicking at consecutive vertices of the area of interest and 

double click to add the last vertex to finish the vectorisation of a polygon; 

o In case you make a vectorisation mistake, click the Undo button in the ArcMap 

Standard Toolbar; 

o Make sure you see enough detail and use the zoom tools while you are vectorising; 

o Experience the different sketch tasks and tools; 

o Once you’ve finished vectorising the area you save your work using Save Edits in the 

Editor menu on the Editor Toolbar. 

o When you want to finish vectorisation, Stop Editing in Editor Menu on the Editor 

Toolbar 

To modify a sketch 

 Insert Vertex 

  



 Delete Vertex  

 

 

 

 

 Move vertices delta X, Y or exact X, Y 



 
 

 

 

LO 2.8: Modify attribute table 

● Content/Topic 1: Table option 

Attribute Tables for Shape files 

 Every shape file has an attribute table associated with it. You can open the table by right clicking on the 

shape file name and going to “open attribute table.” The table will have as many rows, or records, as it 

does map features. The total number of records will be shown at the bottom of your table. There can be 

any number of columns (fields). Two columns are standard: FID, the feature ID, and Shape, which can be 

point, polyline, or polygon. The rest of the fields will vary. In most cases, there will also be a column that 

identifies each map feature with a unique name, such as a census tract number or neighbourhood name. 

There may be additional fields identifying attributes of the map feature (type of crime at a particular 

address, number of people living in a census tract). 

 



 
 

You can work with tables—sort values, freeze columns, generate summary statistics, select records, and 

export tables—without worrying about messing up your original data the way you can in Excel if you are 

not careful. You cannot change any of the data in your table unless you go to “start editing” from the 

editor toolbar… except to add or delete fields. 

Sorting records  

You can sort values in an attribute table by right clicking on the field name and going to “sort ascending” 

or “sort descending.” 

 

Summary Statistics  

You can bring up summary statistics for any numeric field (numeric fields will be justified right) by right 

clicking on the field name and choosing “Statistics.” You can obtain summary statistics on additional fields 

from the drop down menu. 

 

Freezing columns  

Freeze a column (meaning that it will remain in view even as you scroll) by right clicking on the field name 

and going to “Freeze/Unfreeze column.” 

  



 
 

Exporting Tables  

You may need to export your table from Arc Map, because you have made changes, need to convert a .txt 

table to .dbf, or for any other reason. With your table open, go to the options menu and “Export.” If you 

have some records highlighted, you can choose to export just the selected records or all of the records. 

 

Delete Field  

You can delete a field by right clicking on its name and going to “Delete Field.” Arc Map will give you a 

warning that the deletion is permanent and not reversible. Do this with caution. Changes will be 

permanent not just within your map document, but in your original file on your hard drive, as well. 

 

● Content/Topic 2: Calculate geometry 

You may find it easier to edit your attribute tables outside of Arcview, but Arcview has fairly sophisticated 

tools for calculating values. In Arcview, you can edit values in an existing field or create a new field and 

calculate new values. Keep in mind that you cannot change the format (text, integer, long integer) of an 

existing column, so if you need to transform the format of a column, you will need to create a new field. 

Creating a new Field  

To create a new field, open your table in Arc Map (you can also add fields from Arc catalog). This can be a 

free-standing table or one that is associated with a map layer, but only .dbf tables can be edited. Click on 

the Table Options menu (top left corner of the attribute table) and go to “Add Field.” If this option is 

grayed out, you do not have permission to edit the table. Most likely, this is because your table is in 



 
 

.xlsformat. If this is the case, export the table (an option within that same menu) and save it as a .dbf. Add 

the .dbf version back in and try again. 

From “Add Field,” give your field a name. Do not use?,&,$,#,@,*,!,~ or spaces and keep your field name to 

10 or fewer characters. From the dropdown menu, choose the type of field. Different field types allow 

different types of values: 

Short integer: numeric, no decimal place, up to 19 characters  

Long integer: numeric, no decimal place, up to 19 characters  

Float: numeric, with decimal places, (default 1 before decimal and 11 after)  

Double: numeric, with decimal place (default 7 before decimal and 11 after) 

Calculating values outside an Edit Session 

 To calculate the value of your new field (or an old field), right click on its name and go to “calculate 

values.” ArcMap will ask you if you are sure that you want to calculate values outside an edit session, 

warning that you will not be able to undo your results. Say “yes.”  

ArcMap will bring up the Field calculator. If your value is a constant, you can simply type the value in the 

box at the bottom. More likely, your new value will be based on values in other fields, so you will need to 

use the calculator. You can create an expression by double clicking on the field names. For example, to 

calculate the percent of the population 65 and up, click on the field name with the total 65 and up, click on 

the “/” button, and click on the field name with the total population. If any of the records in your table are 

highlighted, ArcMap will only perform calculations on the highlighted records. You can also calculate values 

from Arc Toolbox (under “Data Management Tools”, then “calculate Field”). 

 

Calculating Area  



 
 

Usually there will be a field called “area” in a shape file when you receive it that indicates the area of each 

polygon map feature. If your shape file is missing this field or if you have edited the shape and size of the 

map features, you will need to calculate area, yourself. Area can be especially helpful when you are trying 

to normalize values and create densities (calculating persons per square mile, for example).  

Create a new field called “area” and format it as a double. Right click on your new field and go to “calculate 

Geometry.”  From the “Property” menu, choose “Area.” note the projection and map units. You can 

change the units as long as the projection is defined (known). 

 

● Content/Topic3: Spatial Query 

 Select by attribute 

You highlight a feature on the map by clicking on a row in the table (you need to click in the gray area on 

the far left). This way, you can find a specific place on your map. You can change the selection color from 

“options…” in the Selection menu. It is also possible to use different selection colors for each layer. 

 

To unselect records (and get rid of the blue highlight), you can do one of several things:  

1. Open the attribute table (right click on the name in the Table of contents and go to “Open Attribute 

Table”) and then click on the “clear Selected Features” button at the top;  



 
 

2. with the attribute table open, click on the “Table Options” button on the top left and go to “clear 

Selection” ; 

3. From the Selection menu in ArcMap, choose “clear Selected Features;  

4. From the Table of contents, click on the “list by Selection” button to see which map layer has selected 

features, then right click on the one with selected features and go to “clear Selected Features.” 

 Select by location 

You can also use the select features tool to identify attributes, either by clicking on a particular map 

feature or by drawing a rectangle, polygon, circle, line or using the lasso selection tool. The selected 

features should become highlighted with a blue outline. Right click on the map layer that contains the 

feature(s) that you wish to investigate and go to “open attribute table.” This table includes all the 

attributes of all the features in that layer. In order to view just the selected feature(s), click on the “Show 

Selected Features” button at the bottom of the table. Notice that there will be an indication of how many 

records out of the total have been selected. 

 

LO 2.9: Edit shape files. 

Before you start editing, ensure the shape file has the correct projection defined so Arc Map can display it 

with other projected data. Although you can edit data in different coordinate systems, it is generally best if 

all the data you plan to edit together has the same coordinate system as the data frame. This is especially 



 
 

important for shape files because shape files sometimes are created with an unknown coordinate system 

or have missing projection (.prj) files 

● Content/Topic 1: Edit point shapefiles 

 

Open Arc Map  

Add data  

Select shape file  

 Add shape files as layer  

Editor tool  

 Start editing  

 Open attribute table  

 Select point feature,  

 Use editor tools  

 Use snapping toolbar (optional)  

 Save edit  

 Stop editing  

 

 Content/Topic 2: Edit line shape files 

 

Open Arc Map  

Add data  

Select shape file  

Add shape file as layer  

Editor tool  

 Start editing  

 Open attribute table  

 Select line feature,  

 Use editor tools  

 Use snapping toolbar (optional)  

 Save edit  

 Stop editing  

 Content/Topic 2: Edit polygon shape files 



 
 

Open Arc Map  

Add data  

Select shape file  

Add shape file as layer  

Editor tool  

 Start editing  

 Open attribute table  

 Select polygon feature,  

 Use editor tools  

 Use snapping toolbar (optional)  

 Save edit  

 Stop editing  

LO 2.10: Make layout. 

● Content/Topic 1: Layout view 

When you open ArcMap, you are in “Data view” and use the Tools toolbar to navigate your map. When 

you switch to the layout view, you have access to a different range of tools and use the layout toolbar to 

navigate. To switch to “layout view,” click on the icon at the bottom of your map display that looks like a 

piece of paper (next to the globe icon) or, from the view menu, go to layout view. 

 

 Setup the layout page 

 



 
 

 

 If you don't need to use printer setting, desactivate "Use Printer Paper Settings'"  

 For example, set paper size at "A4" and Orientation at "Landscape"  



 
 

 



 
 

 

 Add data to use in the map 

 



 
 

 

Working with Grids and rulers 

 You can bring up a number of options aimed at helping you to place the objects within your 

layout by right clicking in your layout outside of the neat lines. From “Options,” you can specify 

ruler units and turn on and off rulers and grids when the “layout Options” tab is highlighted. 

Choosing to “snap” to the grid or rulers will help you to line up objects, but it will also limit your 

ability to make fine-level adjustments. 

 



 
 

 



 
 

 

 Set interval 

 



 
 

 Choose text style 



 
 

 

● Content/Topic 1: Insertion of Map Elements 



 
 

When you select Layout View to start adding map components, all components are gathered in the menu 

of Insert 

 

Legend  

Title  

North arrow  

Scale  

Author  

Date  

Grids  

 

● Content /Topic3: Page and print setup 

o Paper size and paper orientation  

You can use the tools on the Layout toolbar to change the size and position of the virtual page on your 

screen or to zoom in or out of the virtual page. 

 



 
 

You can also use the Tools toolbar in Layout view to change the extent of the layers that are shown in the 

data frame. 

 

Right-click the page and click Page and Print Setup. 

 

The ‘Page and Print Setup’ window will appear. Make sure that under ‘Map Page Size’ the option to ‘Use 

printer Paper Settings’ is not ticked. You will then be able to select a page size and paper orientation. You 

do not have to select a printer at this stage. Set the layout’s page size and orientation using the options 

under ‘Map Page Size’. The option at the bottom of the window ‘Scale Map Elements proportionally to 

changes in Paper Size’ will rescale your data to fit your new page size. When you are happy with your 

settings, click OK. The layout page and rulers will change according to the new page size and orientation. In 

this case the paper size has been increased and the orientation has been changed from portrait to 

landscape. 



 
 

 

Click Landscape under Paper and Page to change the page orientation, and then click OK. 

 

Now the page is in landscape orientation. 

 

Resizing and Moving the Map Display in the Layout Page 



 
 

You can resize the view of your map data (the data frame) by clicking on the ‘Select Elements’ icon in the 

‘Tools’ toolbar and clicking on the data frame within the layout page. The data frame will be surrounded by 

a blue selection box. To move the data frame click with the mouse and drag to a new position. To resize 

the data frame use the blue selection boxes, by clicking and dragging any of the boxes at the top, bottom, 

sides or corners. 

 

● Content /Topic5: Exporting Format  

When you are satisfied with everything in the map and are ready to deliver, you can export your map by 

the menu of File -> Export Map 

 



 
 

You can export a map from Arc Map when you are in Data view or layout view. However, if you want your 

exported map to include titles, legends, scale bars, north arrows, and anything else you added to the 

layout, you’ll want to export from layout view. From the File menu, go to “Export Map.” There are many 

options for export formats in the “Save as type” drop down menu. 

.PDF: The .pdf format allows you to open the map directly (without inserting it into PowerPoint or MS 

word) as long as you have Acrobat reader. This is probably the best option if you need to send someone a 

map or post a map on the Internet. 

.JPG: The .jpg format will compromise the quality of your image, so be sure to click on the “options’ button 

when you export and increase the resolution to at least 200 dpi (300 dpi will be as good as you need for 

most things). The .jpg format is good because it stores your map in a fairly small file. 

.TIF and .EPS: The .tif and .eps formats work well if you are going to open your maps in a graphics software 

package, but they result in larger files. 

Other than export map to other file formats, you can directly print out hardcopies of your map by File -> 

Print. You can preview the result via File -> Print Preview to ensure satisfactory result. 

  



 
 

Learning Unit 3: Perform Arc Catalog  
LO 3.1: Create shape file  

● Content/Topic 1: Features types 

Feature classes are homogeneous collections of common features, each having the same spatial 

representation, such as points, lines, or polygons, and a common set of attribute columns, for example, a 

line feature class for representing road centerlines. The four most commonly used feature classes are 

points, lines, polygons, and annotation (the geodatabase name for map text). 

In the illustration below, these are used to represent four datasets for the same area: (1) manhole cover 

locations as points, (2) sewer lines, (3) parcel polygons, and (4) street name annotation. 

 

In this diagram, you might also have noted the potential requirement to model some advanced feature 

properties. For example, the sewer lines and manhole locations make up a storm sewer network, a system 

with which you can model runoff and flows. Also, note how adjacent parcels share common boundaries. 

Most parcel users want to maintain the integrity of shared feature boundaries in their datasets using 

a topology. 

As mentioned earlier, users often need to model such spatial relationships and behaviors in their 

geographic datasets. In these cases, you can extend these basic feature classes by adding a number of 

advanced geodatabase elements, such as topologies, network datasets, terrains, and address locators. 



 
 

You can learn more about adding such advanced behaviors to your geodatabases in Extending feature 

classes. 

Types of feature classes 

Vector features (geographic objects with vector geometry) are versatile and frequently used geographic 

data types, well suited for representing features with discrete boundaries, such as streets, states, and 

parcels. A feature is an object that stores its geographic representation, which is typically a point, line, or 

polygon, as one of its properties (or fields) in the row. In ArcGIS, feature classes are homogeneous 

collections of features with a common spatial representation and set of attributes stored in a database 

table, for example, a line feature class for representing road centerlines. 

Note: 

When creating a feature class, you'll be asked to set the type of features to define the type of feature class 

(point, line, polygon, and so forth). 

Generally, feature classes are thematic collections of points, lines, or polygons, but there are seven feature 

class types. The first three are supported in databases and geodatabases. The last four are only supported 

in geodatabases. 

 Points: Features that are too small to represent as lines or polygons as well as point locations (such as GPS 

observations). 

 Lines: Represent the shape and location of geographic objects, such as street centerlines and streams, too narrow 

to depict as areas. Lines are also used to represent features that have length but no area, such as contour lines 

and boundaries. 

 Polygons: A set of many-sided area features that represents the shape and location of homogeneous feature 

types such as states, counties, parcels, soil types, and land-use zones. 

 Annotation: Map text including properties for how the text is rendered. For example, in addition to the text string 

of each annotation, other properties are included such as the shape points for placing the text, its font and point 

size, and other display properties. Annotation can also be feature linked and can contain subclasses. 

 

● Content/Topic 2: Types of shape file 

 Polygon shape file 

Click on the Arc Catalog tab (if the Arc Catalog window is already not visible). 



 
 

 

n Arc Catalog, right-click on your project folder (i.e. the folder where you want to create your new shape 

file), then select New >> Shape file. 

 

Name the new polygon Poly1 and define the feature type as a polygon 



 
 

 

It’s also a good idea to assign the coordinate system to your new shapefile. In this example, we will assign a 

UTM NAD83 Zone 19N coordinate system to Poly1. 

Click on the Edit… button then select Projected Coordinate Systems >> UTM >> NAD 1983 >> NAD 1983 

UTM Zone 19N. 

 

Click OK to close the coordinate system selection window and OK again to close the Create New Shape file 

window. 

Note that you might encounter a warning message window indicating that the shape file’s coordinate 

system does not match that of the data frame; this is OK for this tutorial but ideally, you will want your 

new shape file to inherent your existing project’s coordinate system. 



 
 

 

At this point, you should see the new shape file in the project folder. 

 

Next, you will create a new feature in the Poly1.shp object. 

 Edit the new polygon shape file 

Right-click on the Poly1 layer in the TOC and select Edit features >> Start Editing. 

 

You might see the following Warning message indicating that the layer to be edited may not match the 

data frame’s CS; click Continue to ignore the message. 



 
 

 

You’ll note the presence of a new window (the Create Features window). This window allows you to select 

the construction tool of your choice to create your new polygon feature. 

Select Poly1 from inside the Create Features window. This action will display the construction tools 

available to your new shapefile. 

 

Choose any construction tool; in this example, we’ll choose the Polygon construction tool. 

Next, digitize the new polygon in the main window by left-clicking the mouse. Each click of the mouse 

creates a new vertex which defines the end-points of each line segment. Here are a few pointers that you 

might find helpful when digitizing a new feature: 

 If you want to remove the last vertex created, click Ctrl+Z 

If you started editing a new feature but want to start over, right-click in the window and select Delete 

Sketch 



 
 

You can zoom in and out as you are digitizing by rolling the middle mouse button. 

You can pan (move) around the map extent by pressing and holding the middle mouse button 

To delete a polygon, simply select it with the selection tool then press the Delete key. 

  

 

To complete the outline of the polygon, press the F2 key. 

When you are done editing your new shapefile you must save, then close the edit session as follows: 

Look for the Editor toolbar then click on Editor >> Save Edits, 

 

 

then click Editor >> Stop Editing. 



 
 

 

Note that it’s important that you save then close your edit session before using the newly created shapefile 

in any subsequent geoprocesses (such as a clipping operation)! 

  

Points shape file and polyline shape file  

The workflow for creating a new point or polyline shapefile is nearly identical. The two differences are in 

the choice of Feature Type (i.e. Point or Polyline), 

 

And in the choice of Construction tools. 

      

     



 
 

    

 

 

● Content /Topic3: Shape file creation steps 

 Open ArcCatalog  

 Create/Select folder location  

 Folder names  

 Create shapefile:  

 Right click on named folder  

 New shapefile  

 Shapefile name  

 Feature types  

 Edit  

 Define spatial references  

LO 3.2 Create Geo-data base 

● Content/Topic 1: Geo-data base types 

 File Geo-database  

 Personal Geo-database  

Creating a personal geo-database 

You’ll create a personal geo-database within the project folder to store several of the updated and new 

datasets you’ll create during the project. Using a geo-database is an efficient way of storing, accessing, and 



 
 

managing data. 

1. Click the project folder connection you just created to see its contents in the right side of the Catalog window. 

 

2. Right-click the project folder connection, point to New, and click Personal Geo-database. 

 

You will see additional options if you are using Arc Info  The new geo-database is listed in the right side of the 

Catalog window with its name highlighted (New Personal Geo-database). 

 

3. Rename the geo-database by typing “Water Project” over the highlighted text. Press Enter. 

 

 Arc SDE Geo-database  

 

● Content /Topic2: Geo-database creation steps and its components 



 
 

 Open ArcCatalog  

 Create/Select folder location  

● Right click on specific Disk-New folder  

● Folder names  

● Create Geo-database  

 The geo-database is a collection of geographic datasets of various types;  

 To create a geo-database you have to launch/start ArcCatalog;  

 In the ArcCatalog, right-click the cell folder or open the folder;  

 New;          

 File Geo-database;  

 

 The new Geo-atabase is created inside that folder, and give it a name such as 

Define Feature dataset (Create new feature dataset)  

 Once the Geodatabase is created, right click on it or open it 

  New  

 Feature Dataset 

 



 
 

 

 Name it "Southern Province"  

 Click Next 

 

 A new dialog box appears 

 Click New Projected 



 
 

 

 A new projected coordinate system dialog box appears. And fill it as 

follows: 

1. Name: ITRF_2005 

2. Projection Name: Transverse_Mercator 

3. - False_Easting: 500000 

- False_Northing: 5000000 

- Central_Meridian: 30 

- Scale_Factor: 0.9999 

-Latitude of Origin: 0 

- Click “Select” on the Geographic Coordinate System area 



 
 

 

 

 

 . Creating Feature Class 

In the Arc Catalog right click on the Feature Dataset or open it 

 New 

 Feature Class 



 
 

 

 A New Feature Class dialog box opens; fill it as follows: 

 Name: Cell name Vectorised (Rurambi_Vectorised) 

 Type: Polygon Features 

 Click “Next’’ 

 You are redirected to New Feature Class dialog boxes 

 Click Next 

 Next 

 Finish 



 
 

 

 



 
 

 

 

LO 3.3: Explore Meta data 

● Content/Topic 1: Meta data content 

 Summary  

 Description  

 Credits  

 User limitation  

 Extend  

 Scale  

 Size  

 

● Content/Topic 2: Metadata Modification 



 
 

● Shapefile properties  

 Content,  

 Preview,  

 Description  

 Review  

 Update  

 

● Content /Topic3: Metadata validation 

 Data access  

 Rules and behavior  

 Metadata properties  

 Data redundancy  

 

 

  



 
 

Learning Unit 4: Perform Arc tool box  
LO 4.1: Identify Arc Toolbox 

 

 Content/ Topic 1: 3D analyst tools  

3D Analyst Tools provides tools to work in 3D. For example, you can work with City Engine, LAS and 

multipath features. Here are some examples for what you can do with 3D Analyst Tools: 

 3D features  

 Conversion  

 Data management  

 Raster interpolation  

 Raster surface  

 Triangulated surface  

 Recognize visibility like line-of-sight, view sheds and skylines. 

 Measure 3D surfaces, volumes and slopes 

As part of the 3D analyst extension, you can use the line-of-sight tool. Then, if you use a digital elevation 

model, you can determine obstructed (red) and unobstructed (green)  

 

 Content /Topic 2: Analysis tools  

The analysis tools perform the most fundamental GIS operations. For example, it has your basic extract, 

overlay, and proximity tools. But it also solves basic statistics like finding the mean, counts, and standard 

deviation. 

 Perform overlay operations like intersect, union and spatial join. 

 Find proximity using buffers and near tables. 

 Extract features by selecting, clipping and splitting features. 

The buffer is an example of a tool in the analysis tools. When you set a value, it generates a polygon 

around features at a set distance. 



 
 

 

 Content/ Topic 3: Conversion tools  

Conversion tools alter data types between different GIS file formats. For example, you can convert tables, 

vector, and raster data. You can also work with web, 3D, and CAD files too. 

 From GPS  

 From KML  

 From raster  

 To CAD  

 To KML  

 To Raster  

 To shape file  

 Excel 

 PDF 

 Raster 

 JSON 

 Web 

 COLLADA 

 Geodatabase 

 Geopackage 

 

 Content/ Topic 4: Data management tools  

Data management tools help develop, manage and maintain data structures. Also, it includes tools to 

detect changes, administer geodatabases and project data. Data management tools include support for the 

following file types and more: 

 Field  

 Attachments 

 Domains 

 Fields 

 Geodatabases 

 Graphs 

 LAS Datasets 

 Photos 

 Rasters 

 Relationships 

 Tables 

 Projection and 

transformation  

 Workplace 

  

 Content/ Topic 5: Editing tools  

Editing Tools provide a way to bulk edit a set of features. So, instead of just editing a single feature as you 

would do with the Editor Toolbar. You can apply edits to multiple features using tools. If you don’t want to 

edit all features, you can make a selection from your features. 

 Erase point Generalize, densify, extend, snap; trim line and erase a set of features. 

 Conflate two datasets by aligning features at boundary lines. 



 
 

For example, the “extend” tool ensures that all lines stretch and snap to a boundary. By running this tool, 
you ensure that all lines extend given a tolerance value. 

 Content/ Topic 6: Spatial analyst tools  

The spatial analyst extension is for specialized raster analysis. By analyzing raster data cell-by-cell, you can 
perform map algebra and zonal statistics. For example, this extension allows you to: 

 Generate least-cost distance corridors and basic interpolation. 

 Create land cover by image classification techniques. 
 Perform groundwater, hydrology and solar radiation analysis. 

 

LO 4.2: Use Geo-Processing Tool 

 

 Content/ Topic 1: Buffer  

 Road buffer  

 River buffer  

What neighborhood is affected by 10m river buffer?   

 Open Arc catalogue 

   Analysis tool 

   Proximity 

   Buffer- a dialogue box is open 

   In the input Feature put River 

   Output Feature class browse to your data storage and give the name. 

   Linear Unit: 10 – select Meters 

   Leave other tabs as default 

   Ok   



 
 

 

 

 Content/ Topic 2: Clip  

 Forest clipping  

 Roads clipping  

Clipping allows you to turn one shapefile into a cookie-cutter in order to cut out part of a larger shapefile. 

For example, you might need to create a map layer of streets for the area within a single police district but 

your street centerline file covers the entire city. Using a street file that is clipped by the police district 



 
 

boundaries will allow you to work with a smaller and more manageable file that looks neater. From the 

Geo-processing menu, go to “clip.” On the next screen, you need to identify an input feature (the layer to 

be clipped) and the clip features (cookie cutter). The default name for the new shapefile will be the input 

feature name plus “_clip.” If you want to change this or the location of the new file, click on the folder to 

the right. You can leave “cluster Tolerance’ at 0. Changing it will allow slightly mismatched map layers to be 

considered “coincident.” 

 

 Content/ Topic 3: Intersect  

 Road network  

 Streets  

Intersect allows you to fuse two overlapping layers together to create a new shapefile that includes the 

attributes of both layers for the area in which the layers overlap. In effect, this combines the union 

(described below) and clip operations. You can intersect two polygon layers or a line and polygon layer. 

From the Geoprocessing menu, select “Intersect.” On the next screen, select the input features. The 

default name for the new shapefile will be the first input feature name plus “_Intersect.” If you want to 

change this or the location of the new file, click on the folder to the right. If you intersect a line and 

polygon layers, the resulting shapefile will contain “polylines” that act like lines. If you intersect polygon 

layers, the resulting shapefile will contain polygons. Length, perimeter, and area values will be inaccurate 

after you perform an intersection, so if you need these, be sure to recalculate them. 



 
 

 

 Content/ Topic 4: Union  

 Parcels  

 Plots  

 Section of land  

Union is similar to intersection in that it fuses the boundaries of two layers together, but rather than 

clipping the resulting shapefile to include only the area covered by both, it creates a new shapefile that 

covers the combined extent of the layers. From the Geoprocessing menu, choose “Union.” On the next 

screen, select the input features. The default name for the new shapefile will be the first input feature 

name plus “_Union.” If you want to change this or the location of the new file, click on the folder to the 

right. 

 

 Content/ Topic 5: Merge  

 Parcels  

 Plots  



 
 

 Sections of land  

 

Appending allows you to incorporate two or more non-overlapping layers into a single map layer without 

changing their map features. You can append point, line, and polygon layers. Appending can save you time 

when it comes to symbolizing features and lead to more consistent symbology. For example, you can 

merge census tract files from several counties so that when you display the percent of homeowners, you 

don’t have to repeat the process of classifying your data for each county. 

From ArcToolbox, you can find “Append” under “Data Management Tools” and “General.” Under “input 

features,” list all the map layers you wish to merge. You can use the dropdown menu if you have added the 

map layers to ArcMap, but you will need to add them one at a time (if you add them directly from your 

computer, not from ArcMap, you can highlight multiple shapefiles and add 

….. 

 

LO 4.3: Use Management Tools 

 

 Content/ Topic 1: Field  

 Table terminology

 

• attribute data are organized in database tables 

Arc Map  

•  Right click a data layer in the data frame 



 
 

•  Open Attribute Table 

Add field  

 

 

 

 

 



 
 

 

 Delete field  

 Calculate field  

• Can do this either through Arc Toolbox or the Column Context Menu (right-click on column name) 

• Both present you with a Field Calculator 

• Can also delete the field if you are not happy with it = permanent! 

 

 

 Content/ Topic 2: Projection and transformation 

 

 Create spatial reference  

 Define projection  



 
 

1. In Arc Catalog, click the Show/Hide Arc Tool box button on the toolbar. 

 

2. Double-click Data Management Tools in the Arc Toolbox tree; double-click Projections and 

Transformations, then double-click the Define Projection tool. If you are using Arc Info you will see 

additional tools not shown here. 

 

The Define Projection dialog box appears. You defined the coordinate system for the lowland shape file 

using the Properties dialog box in Arc Catalog. Arc Tool box provides an alternate way of defining a 

coordinate system. 

3. Click the Input Dataset or Feature Class browse button and navigate to the Country share folder 

under the project folder. 

 

4. Click on the shape file you want in this course notes we use river to define and click Add. 



 
 

 

determined that the shape file is in geographic coordinates— latitude–longitude—however, you need 

to explicitly define the geographic coordinate system before you can project the data.  

5. Click the button next to Coordinate System. 

 

The Spatial Reference Properties dialog box appears. 

 

There are three ways of defining a coordinate system: using a predefined coordinate system stored as a 

.prj file, matching the coordinate system of an existing dataset by specifying the name of the dataset, or 

interactively specifying a projection and a datum and their associated parameters. In this case, you’ll be 

specifying a predefined coordinate system.  

6. Click Select on the Spatial Reference Properties dialog box. The Browse for Coordinate System 

folder opens. 



 
 

 

ArcGIS provides many predefined coordinate systems for you to use, stored as. prj files. The files include all 

the coordinate system parameters including the map projection type and parameters, measurement units, 

and so on. You can also define custom coordinate systems and save them as. prj files—for example, the 

state dot. prj file 

7. Double-click Geographic Coordinate Systems 

 

The coordinate system information is displayed in the Details window. 

 

8. Click OK to close the Spatial Reference Properties dialog box.  

9. Click OK.  

10. Click Close to close the Define Projection dialog box. 



 
 

 

 

LO 4.4: Use Data Conversion Tools 

 Content/ Topic 1: KML Conversion  

 KML to layer  

 Layer to KML  

 Map to KML  

 Open and Review Shape file via ArcMap  

 Define that Shape file’s symbology as desired 

 Open ArcMap’s Toolbox 

– Navigate to Conversion Tools: Layer to KML 

• Double-click ‘Layer to KML’ 

• Select the symbolized ‘layer’ 

• Define the output file (KML) 

• Define the Scale (try 1000) 

• Click ‘OK’ 

 Open Google Earth 

 Open KML in Google Earth 



 
 

 

 

 

 Content/ Topic 2: Raster Conversion  

 

 Raster to point  

 Raster to polyline  

 Raster polygon  

 Feature to raster  

 Polilyne to raster  

 Polygon to raster  

 DEM to raster  

E. g You’ll use the Grid to Polygon Coverage tool to complete the conversion.  

1. Double-click Grid to Polygon Coverage in the Export from Raster toolset in Conversion Tools 

 

3. Browser your folder and file location in the Output coverage text box. Click OK. 



 
 

 

When the tool is finished processing the request, you should see your new feature 

 

3. Click the Preview tab in Arc Catalog to view the Old grow coverage in Preview view. Zooming in reveals the 

common stair-step effect found in vector data that has been converted from raster data.  

4. Examine the attributes for the coverage’s polygon feature class. Areas of old growth have a GRID-CODE value of 1. 

All other areas were No data in the grid and have a value of -9999. When inadequate information is available for a 

cell location of a grid, the location can be assigned a value of No data. No data and 0 are not the same; 0 is a valid 

value. Because No data represents inadequate information, No data cells cannot be used in calculating the statistics 

in a grid’s statistics (STA) table. 

 

 Content/ Topic 3: Shape file Conversion  

SDC Feature Classes are compressed file formats that need to be converted to another file format to be 
fully editable. Arc Toolbox has several tools that can accomplish this. SDC Feature Classes can be converted 



 
 

to File, Personal or Arc SDE geodatabases, and shape files using these procedures. 

 

 Procedure 

 Arc Tool box: Feature Class to Geodatabase 
 
Open the Conversion toolbox and open the Feature Class to Geodatabase tool. 

 
 Enter the SDC data that is to be converted. Specify the input data and the output geodatabase 

using the open folder buttons. 



 
 

 
 

 
 Click OK to start the conversion. Once complete, the output geodatabase contains the newly 

converted feature classes. 

 Arc Tool box: Feature Class to Feature Class 
 
Open the Conversion toolbox and open the Feature Class to Feature Class tool. 



 
 

 
Specify the SDC feature classes and output data to be converted using the Open file buttons. 
 
Click OK to start the conversion. Once complete, the output geodatabase contains the newly 
converted feature classes. 

 Arc Toolbox: Feature Class to Shape file 
 
Open the Conversion toolbox and open the Feature Class to Shape file script. 

 
Enter the SDC data to be converted. Specify the input data and the output destination for the 
shape file using the open folder buttons. 
 
Click OK to start the conversion. Once complete, the output geodatabase contains the newly 
converted shape files. 
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